Creating Analyses and Dashboards

Overview

Purpose

In this tutorial, you will learn how to build, format, and customize Oracle Business Intelligence (BI) analyses and create and update dashboards by utilizing these analyses.

Time to Complete

Approximately 2 hours

Introduction

Oracle BI is a comprehensive collection of enterprise business intelligence functionality that provides the full range of business intelligence capabilities, including dashboards, full ad hoc, proactive intelligence and alerts, and so on. Typically, organizations track and store large amounts of data about products, customers, prices, contacts, activities, assets, opportunities, employees, and other elements. This data is often spread across multiple databases in different locations with different versions of database software.

After the data has been ordered and analyzed, it can provide an organization with the metrics to measure the state of its business. This data can also present key indicators of changes in market trends and in employee, customer, and partner behavior. Oracle BI helps you obtain, view, and analyze your data to achieve these goals.

In this tutorial, you will learn how to create analysis, add graphs, work with pivot tables, format the analysis and graphs, create performance tiles, simple trellis charts, column and view selectors, work with other views, create a dashboard, and add user interactivity and dynamic content to enhance the user experience. You create analysis and work with views including graphs, pivot tables, and narratives.

This course includes the new enhancements that make the application more flexible and highly performing (Housekeeping changes for UI, Client Installer, Right Click Interactions, Sorting Measures, View enhancements, Hierarchy additions, Prompt Enhancements, and so on.) You will then create selectors to drive interactivity in your analysis, and build a custom dashboard, which contains the newly created analysis and views. Finally, you will create flexible dashboard prompts to filter your dashboard and populate variables.

Hardware and Software Requirements (Optional)

The following is a list of software requirements:

- Oracle BI EE 11.1.1.7 or later must be installed
- Windows 2000 or later must be installed
- Access to Oracle Database 11.2 or higher

Prerequisites

Before starting this tutorial, you should:

- Have proper permissions to configure the dashboards.
Beginning the Analytic Process

In this topic, you will learn how to access Oracle BI EE to create an analysis. The new enhancements for the version 11.1.1.7.0 - Favorites Menu, global header links, sorting are covered under this topic.

Logging In

This topic will cover the general navigation to start with the analytic process. To log into Oracle BI EE and begin creating an analysis, perform the following steps:

Navigate to the SWIFT Administrative Portal Sign In page and sign in.

a. Select SWIFT Data Warehouse Access, Warehouse Training

When you sign in, the Tutorial Dashboard is displayed.

To get to the Home page select “Home” in the menu bar.

The Home page is a task-oriented, centralized workspace combined with a global header, allowing access to Oracle BI EE objects, their respective editors, help documentation, and so on.

Home Page contains global header, Create New section, Catalog Management section, Get Started section with links to additional help and BI tools, Recent section displaying the recently viewed or created analysis or dashboards, and Most Popular section. You can always operate these features from the global header as well.

Observe that there is a new link in the global header for Favorites section. This is a new enhancement.
Favorites Menu

Favorites allow you to bookmark your favorite Catalog objects, such as analysis, dashboards, and reports.
You can view your favorites list and open your favorite objects from the global header's Favorites menu. This topic covers how to manage favorite objects.

You can add catalog objects to favorites using the following steps:

a. Select an object (analysis or the dashboard) from the catalog. In this example select the analysis Quarterly Revenue.

b. Click More drop-down list and select the task Add to Favorites.
The selected analysis or object is displayed with a gold star symbol.

You can also add the catalog object to favorites by using the tasks pane as shown below.

a. Select the object - a report, analysis, or a dashboard.

b. Click the **Add to Favorites** task from the task pane.
The analysis is displayed as a favorite object in the catalog page.

You can also add the object from the viewer window.

Open the object, in this example it is an analysis.

Click **Favorites** menu, and then select **Add to Favorites**.
The analysis is displayed as a favorites in the catalog page. Observe a star next to the newly added analysis.

You can organize these favorites and also delete the objects from the favorites section based on your business requirements.

**Searching the Catalog (Basic Search)**

This topic covers the basic search of catalog objects from the global header. Depending upon how your system is configured, you will use the basic search or the fully integrated full-text search to quickly find an object within the catalog.

The basic Catalog search, which is the standard search delivered with Oracle BI EE, enables you with the proper privilege to search for objects from the global header and the Home or Catalog pages. In the Catalog page, you can use the basic Catalog search to locate an object by searching for its exact name, description, location, and type, only. You find only those objects for which you have the appropriate permissions. When the desired object is located, you can select the object to display it for viewing or editing, as your permissions allow.

To conduct a basic search for the catalog objects perform the following steps:

a. In the global header's Search field, click the drop-down list, and select the object type for which you want to search.
b. Place your cursor in the field next to the Search field and enter part or all of the object's name or description.

c. Click the arrow icon to begin the search.

The Catalog page is displayed with the results that match your search criteria.

Creating Analysis

Creating an Analysis and Using the Analysis Editor

This topic covers creating a new analysis by using the Analysis Editor.

To build an analysis, do the following:

From the home page, click **New > Analysis**.
The Select Subject Area pop-up appears. A subject area contains columns that represent information about the areas of an organization's business or about groups of users within an organization. When you create a new analysis, this subject area is known as the primary subject area and will appear in the Subject Areas pane of the Analysis Editor. If, as you work, you need more data, you can add additional subject areas if you have permission to access these additional subject areas.
In the Select Subject Area pop-up, select A - Sample Sales. The Analysis Editor is displayed.

Observe the Analysis Editor, to explore and interact with information by visually presenting data in tables, graphs, pivot tables, and so on.
The Analysis Editor is composed of tabs and panes, as shown in the screen shot, representing the subject area (columns), available catalog objects, selected columns for the analysis, and filters (which limit the selected data).

A subject area contains folders, measure columns, attribute columns, hierarchical columns, and hierarchy levels that represent information about the areas of an organization's business or about groups of users with an organization. Subject areas usually have names that correspond to the types of information that they contain, such as Period, Regions, Products, Orders, and so on.

In this example:

- The selected subject area is **A - Sample Sales**
- The four tabs - **Criteria, Results, Prompts** and **Advanced** are displayed at the top of the Editor
- Selected columns pane is empty as you are yet to choose the columns
- Filters is empty as well waiting for the column selections and further criteria

There are various column types in a subject area. They are:

<table>
<thead>
<tr>
<th>Attribute Column</th>
<th>Is similar to a column in a table in a relational data source. Holds a simple list of members, which function as attributes, similar to a dimension. Examples include ProductID or City.</th>
</tr>
</thead>
</table>
**Hierarchy Column**

Is similar to a hierarchy of a dimension in a multidimensional data source. Holds a list in which individual members are shown in an outline manner, with lower-level members rolling into higher-level members, and outline totals being shown for the higher-level members. For example, a specific day belongs to a particular month, which in turn is within a particular year.

Hierarchy columns can also be:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level-based</td>
<td>Consists of one or more levels. For example, a Time hierarchy might have levels for Year, Quarter, and Month.</td>
</tr>
<tr>
<td>Value-based</td>
<td>Consists of values that define the hierarchy, rather than levels. For example, an Employee hierarchy might have no levels, but instead have names of employees who are managed by other employees. Employees can have titles, such as Vice President. Vice Presidents might report to other Vice Presidents and different Vice Presidents can be at different depths in the hierarchy.</td>
</tr>
<tr>
<td>Ragged</td>
<td>A hierarchy in which all the lower-level members do not have the same depth. For example, a Time hierarchy might have data for the current month at the day level, the previous month’s data at the month level, and the previous 5 years’ data at the quarter level. This is also known as an unbalanced hierarchy.</td>
</tr>
<tr>
<td>Skip-level</td>
<td>A hierarchy in which certain members do not have values for certain higher levels. For example, in the United States, the city of Washington in the District of Columbia does not belong to a state. The expectation is that users can still navigate from the country level (United States) to Washington and below without the need for a state.</td>
</tr>
</tbody>
</table>

**Measure Column**

Is similar to a column of data in a table in a relational data source. Holds a simple list of data values. It is a column in an Oracle BI Enterprise Edition repository, usually in a fact table, that can change for each record and can be added up or aggregated in some way. Examples include Revenue or Units Sold.

The screen shot shows folders and columns, and selected **A - Sample Sales** subject area.
a. Select the following columns for your analysis.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customers&gt;Cust Regions</td>
<td>C50 Region</td>
</tr>
<tr>
<td>Products</td>
<td>P1 Product</td>
</tr>
<tr>
<td>Base Facts</td>
<td>1 - Revenue</td>
</tr>
</tbody>
</table>

b. While selecting the columns, click the plus sign to expand the folders and double click the required column names to get them in the Selected Columns section. In this example, expand the Customers folder>Cust Regions, and then double click C50 Region to get it in the Selected Columns section.
c. The selected columns are displayed in the Selected Columns section. Your analysis criteria should look like this:
Note: In the Selected Columns section, you can reorder the columns in your analysis by clicking and dragging them. The image shows the step by step view of reordering the columns.
Click the Results tab. The default Compound Layout is displayed.
The Compound Layout is a composition of many views. By default, both a Title and Table view are defined for you when using attribute and measure columns. A Pivot Table view is automatically created when using hierarchical columns in your analysis.

The Title view allows you to add a title (the default), a subtitle, a logo, a link to a custom online help page, and timestamps to the results. The Table view displays results in a standard table. You can navigate and drill down in the data. You can add totals, customize headings, and change the formula or aggregation rule for a column. You can also swap columns, control the appearance of a column and its contents, and specify formatting to apply only if the contents of the column meet certain conditions.

Note: In the Compound Layout, you can create different views of the analysis results such as graphs, tickers, and pivot tables. These are covered in this tutorial going forward.
Filtering, Sorting, and Saving your Analysis

This topic demonstrates how to filter, sort, and save the analysis you have created above.

You will add a filter to the analysis and then save the filter. Filters allow you to limit the amount of data displayed in the analysis and are applied before the analysis is aggregated. Filters affect the analysis and thus the resulting values for measures. Filters can be applied directly to attribute columns and measure columns.

A filter created and stored at the analysis level is called an inline filter because the filter is embedded in the analysis and is not stored as an object in the Presentation Catalog (Catalog). Therefore, an inline filter cannot be reused by other analysis or dashboards. If you save the filter however, it can be reused and is known as a named filter. (Named filters can also be created from the global header.)

Perform the following steps to filter, sort and save the previously created analysis.

a. Click the Criteria tabbed page. Select the column Cust Regions>C50 Region to create a filter. You can create a filter by hovering over the specific column's toolbar by selecting the More drop-down menu.

b. In the More drop-down menu, select Filter.

You can also create a filter by clicking the "Create a filter for the current Subject Area" icon in the Filters pane and then selecting the column from the drop-down list, as shown in the screen shot.

The column selected for this example is Cust Regions>C50 Region.
Since you have already selected a filter in the previous step you are not using this option.

The New Filter dialog box is displayed. Accept the default value for the operator, that is **is equal to** / **is in**, and enter a column value (or a range of column values) for this condition. To do this, click the drop-down list for **Value**, and click the desired checkboxes. Select **Americas** and **EMEA**.

Click **OK**.

The Filters pane displays the newly created filter.
Save this filter. Click the More Options icon in the filters pane and select **Save Filters** from the drop-down list.

The **Save As** dialog box appears. A filter must be saved to a subject area folder so that it is available when you create an analysis using the same subject area.

Navigate to the Subject Area Contents folder under the My Folders. Select the A - Sample Sales folder. Name the filter **Americas and EMEA filter** and accept the default location. If a Confirm Save Location dialog box appears, accept the default. Oracle BI EE allows you to save any type of business intelligence object to any location within the Catalog. However, for some object types such as filters, Oracle BI EE suggests the best Catalog location.

The **Save As** dialog box should look like this:
Click **OK**.

The Filters pane should look like this:

Next, you save the analysis so that you can verify the creation of your named filter within the Catalog.
a. Click the **Save** icon to save your analysis.

b. Navigate to **My Folders** and click the **New Folder** icon. The New Folder dialog box appears.

c. Name the folder **Regional Revenue** and click **OK**.

Name the analysis **Regional Revenue** and click **OK**.
The analysis is saved to the catalog folder **Regional Revenue**.

Verify the named filter.

Click the **Catalog** link on the global header and navigate to the folder where you saved your filter. **The Americas and EMEA filter** is displayed in the Catalog.

Go to Home page, and in the Recent area, click the **Edit** link for the **Regional Revenue** analysis.
Now you will add a sort to this analysis.

a. On the **Criteria** tabbed page, click the **More Options** icon for 1- Revenue.

b. Select **Sort > Sort Descending**.

Observe that a sort icon is added to 1- Revenue. The order of the sort is indicated by an arrow; in this case, the arrows points down, indicating that it is descending. Additionally, if multiple sorts are added, a subscript number will also appear, indicating the sequence for the sort order.
b. Save your analysis again.

Click the **Results** tabbed page to verify the filter and sort are being applied to your analysis. The Compound Layout display the filtered and sorted analysis.
This concludes the topic of saving an analysis and sorting it.

**Creating Selection Steps for your Analysis**

This topic covers how to add selection steps for the product in the analysis. Both filters and selection steps allow you to limit the data displayed in your analysis. Unlike filters that are applied before the analysis is aggregated, selection steps are applied after the analysis is aggregated. Selection steps only affect the members displayed, not the resulting aggregate values. For example, the outline total for the top level of a hierarchy is not affected if some members of the hierarchy are excluded from the selection. Selection steps are per column and cannot cross columns. While measure columns appear in the Selection Steps pane, you cannot create selection steps for them. Note that however, the grand totals and column totals are affected by selections. You can create selection steps for both attribute columns and hierarchical columns.

To add selection steps for **Product**, do the following:

Click the plus icon to expand the **Selection Steps** pane of the Compound Layout.
The Selection Steps pane opens.
Under **Products - P1 Product**, hover over **1. Start with all members**, and click the **pencil** icon.
The **Edit Member Step** dialog box appears with the list of available products.
You will use the shuttle icons to move column members between the Available and the Selected columns.

Click the **Move All** shuttle icon to move all members from **Available** to **Selected** pane.
In the Selected column, select **Install** and **Maintenance** and click the **Remove** icon to return these two members to the **Available** column.

You can use Ctrl-click to select multiple members in the list. Click **OK**. Note that the two members, **Install** and **Maintenance**, that you removed are not selected anymore.
a. The Selection Steps pane appears with the new values added. Observe that you can also save the Selection Steps as an object in the Catalog by clicking the **Save** icon.
b. Click the **arrow sign** icon to minimize the Selection Steps pane

Verify your results by reviewing your analysis in the Table view of the Results tab.
### Formatting and Adding Totals to your Analysis

To add formatting and totals to your analysis, do the following:

To add totals to your analysis, click the **Edit View** icon in the Table view.

<table>
<thead>
<tr>
<th>C50 Region</th>
<th>P1 Product</th>
<th>1.-Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>MicroPod 60Gb</td>
<td>1,834,881</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>MicroPod 60Gb</td>
<td>1,828,738</td>
</tr>
<tr>
<td>EMEA</td>
<td>MPEG4 Camcorder</td>
<td>1,566,529</td>
</tr>
<tr>
<td>EMEA</td>
<td>Tungsten E Plasma TV</td>
<td>1,556,550</td>
</tr>
<tr>
<td>EMEA</td>
<td>LCD 36X Standard</td>
<td>1,516,738</td>
</tr>
<tr>
<td>EMEA</td>
<td>V5x Flip Phone</td>
<td>1,500,550</td>
</tr>
<tr>
<td>EMEA</td>
<td>7 Megapixel Digital Camera</td>
<td>1,412,995</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>Tungsten E Plasma TV</td>
<td>1,374,338</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>LCD 36X Standard</td>
<td>1,364,184</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>MPEG4 Camcorder</td>
<td>1,340,402</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>7 Megapixel Digital Camera</td>
<td>1,293,069</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>V5x Flip Phone</td>
<td>1,276,820</td>
</tr>
<tr>
<td>EMEA</td>
<td>PocketFun ES</td>
<td>1,134,895</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>PocketFun ES</td>
<td>1,118,700</td>
</tr>
<tr>
<td>EMEA</td>
<td>Game Station</td>
<td>1,072,950</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>Game Station</td>
<td>1,054,701</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>Touch-Screen T5</td>
<td>991,342</td>
</tr>
<tr>
<td>EMEA</td>
<td>Touch-Screen T5</td>
<td>911,738</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>KeyMax S-Phone</td>
<td>906,918</td>
</tr>
<tr>
<td>EMEA</td>
<td>SoundX Nano 4Gb</td>
<td>900,642</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>SoundX Nano 4Gb</td>
<td>876,679</td>
</tr>
<tr>
<td>Region</td>
<td>Product</td>
<td>Quantity</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>C50</td>
<td>P-1 Product</td>
<td>1,834,881</td>
</tr>
<tr>
<td>EMEA</td>
<td>MicroPod 60Gb</td>
<td>1,828,738</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>MicroPod 60Gb</td>
<td>1,516,738</td>
</tr>
<tr>
<td>EMEA</td>
<td>MPEG4 Camcorder</td>
<td>1,566,529</td>
</tr>
<tr>
<td>EMEA</td>
<td>Tungsten E Plasma TV</td>
<td>1,556,550</td>
</tr>
<tr>
<td>EMEA</td>
<td>LCD 36X Standard</td>
<td>1,516,738</td>
</tr>
<tr>
<td>EMEA</td>
<td>V5x Flip Phone</td>
<td>1,500,550</td>
</tr>
<tr>
<td>EMEA</td>
<td>7 Megapixel Digital Camera</td>
<td>1,412,995</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>Tungsten E Plasma TV</td>
<td>1,374,338</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>LCD 36X Standard</td>
<td>1,364,184</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>MPEG4 Camcorder</td>
<td>1,340,402</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>7 Megapixel Digital Camera</td>
<td>1,293,059</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>V5x Flip Phone</td>
<td>1,276,820</td>
</tr>
<tr>
<td>EMEA</td>
<td>PocketFun ES</td>
<td>1,134,895</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>PocketFun ES</td>
<td>1,118,700</td>
</tr>
<tr>
<td>EMEA</td>
<td>Game Station</td>
<td>1,072,950</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>Game Station</td>
<td>1,054,701</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>Touch-Screen T5</td>
<td>991,342</td>
</tr>
<tr>
<td>EMEA</td>
<td>Touch-Screen T5</td>
<td>911,738</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>KeyMax S-Phone</td>
<td>906,918</td>
</tr>
<tr>
<td>EMEA</td>
<td>SoundX Nano 4Gb</td>
<td>900,642</td>
</tr>
<tr>
<td>AMERICAS</td>
<td>SoundX Nano 4Gb</td>
<td>876,679</td>
</tr>
</tbody>
</table>

The Table Editor appears.
a. To add a grand total to the analysis, click the **Total** icon to the right of **Columns and Measures** in the Layout pane of the Table editor.
b. Select **After** from the drop-down list. Review the results in the Preview pane, and note that the **Total** icon now displays a green checkmark, indicating that a grand total has been added to the analysis.

<table>
<thead>
<tr>
<th>AMERICAS</th>
<th>MP3 Speakers System</th>
<th>376,815</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMERICAS</td>
<td>Plasma HD Television</td>
<td>372,097</td>
</tr>
<tr>
<td>EMEA</td>
<td>MP3 Speakers System</td>
<td>365,710</td>
</tr>
<tr>
<td><strong>Grand Total</strong></td>
<td></td>
<td><strong>36,332,925</strong></td>
</tr>
</tbody>
</table>

Before adding a total to the Region, remove the sort from **1 - Revenue**.

a. Click the **Criteria** tabbed page.

b. Click the **More Options** icon for **1 - Revenue** and select **Sort > Clear Sort**.

c. Click the **Results** tabbed page and review the Table view to confirm that the sort has been removed from the analysis.
Now you will add a **total by region** to your analysis.

**a.** Click the Edit View icon 🆕 in the Table view. The Table Editor appears.

**b.** In the Layout pane, click the **Total** icon for **C50 Region**.
c. Select **After** from the drop-down list. Review the results in the Preview pane, and note that the **Total** icon now displays a green checkmark, indicating that a total has been added for that specific column/region.
After you create and run an analysis, default formatting rules are applied to the analysis’ results. Default formatting rules are based on cascading style sheets and XML message files. You can create additional formatting to apply to specific results. Additional formats help you to highlight blocks of related information and call attention to specific data elements. You can also use additional formatting to customize the general appearance of analyses and dashboards.

Now you will apply formatting to the **C50 Region** column.

a. You apply formatting to a heading. Click the **More options** icon for **C50 Region** and select **Format Headings**.
The Edit Format dialog box appears.
a. In the Caption text box, enter Region.

b. In the Font area, click the drop-down list for Color and select red color from the Color Selector dialog box and click OK.
c. In the Cell area, click the drop-down list for Background Color and select a light blue color from the Color Selector dialog box and click OK.

![Color Selector dialog box](image)

**d.** Click OK in the Edit Format dialog box to see the results of your format changes for C50 Region.

The Preview pane should look like this:
a. Click the **Table View properties** icon on the toolbar.

The Table Properties dialog box appears.

b. Select the **Enable alternate styling** checkbox, and click **OK**.
c. The Preview pane should look like this. Click **Done** and then save your analysis.
Adding a Graph to an Analysis

In this topic, you learn how to add a graph to an analysis, and apply a saved filter and format the graph.

Enhancing an Analysis by Adding a Graph

In this subtopic, you begin by creating a new analysis to which you add a graph and apply a named filter created in the first topic. Perform the following steps:

Create a new analysis by using the same columns that you used to create Regional Revenue. Click New > Analysis on the global header. Use A - Sample Sales Subject Area.

Add C50 Region from Cust Regions, P1 Product from Products, and 1 - Revenue from Base Facts to Selected Columns.

Next, you will add a named filter that you created to limit the analysis to just Americas and EMEA data previously.

a. In the Catalog pane, navigate to locate your filter named Americas and EMEA filter.
b. Select the filter and click the **Add More Options** icon.

a. In the **Apply Saved Filter** dialog box, select the **Apply contents of filter instead of a reference to the filter** checkbox. This option adds the filter as an inline filter, allowing you to make changes without changing the Catalog filter item. Note that if you do not select this checkbox, the filter is added as a named filter that you can view, but not edit.
b. Click **OK**. The filter is added to your analysis.

Save the analysis to your **Regional Revenue** folder, entering **Regional Revenue Graph** as the analysis name.
You will add a graph to this analysis.

a. Click the **Results** tabbed page, and click the **New View** icon.
b. Select **Graph > Bar > Default (Vertical)** from the menus.
The default Graph view appears below the Table view.
Click the **Remove View from Compound Layout** icon for both Title and Table views.

Both views are removed from the Compound Layout. Note however, that they are still available for use from the Views pane.
Save the analysis.

**Formatting the Graph**

To enhance the appearance of a graph, perform the following steps:

Click the **Edit View** icon to begin your formatting changes. The Graph editor appears.
The Graph, like other view editors, is composed of three sections:

**Toolbar**

The toolbar allows you to change graph types and subtypes, print, preview, edit graph properties, and so on.

**Preview pane**

The preview pane is a dynamic view of the graph, allowing you to view the changes instantly.
The layout allows you to change the properties of prompts, sections, measures, and so on, and allows you to regroup columns for graph display.

Click the **Edit properties** icon.

The Graph properties dialog box appears.
The Graph properties dialog box is composed of four tabbed pages: General, Style, Scale, and Titles and Labels. These tabbed pages allow you to do the following:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Set properties related to the graph canvas, such as canvas width, height, legend location, and so on.</td>
</tr>
<tr>
<td>Style</td>
<td>Set properties that control the appearance of the graph such as plot area and gridlines.</td>
</tr>
<tr>
<td>Scale</td>
<td>Set properties for parts of the graph, that is axis limits and tick marks.</td>
</tr>
<tr>
<td>Titles and Labels</td>
<td>Set properties that control the display of titles and labels for the graph.</td>
</tr>
</tbody>
</table>

a. Select **Enable for Horizontal Axis** from the “Zoom and Scroll” checkboxes. When zooming and scrolling is enabled for a graph, then the graph includes a Zoom icon. The Zoom icon allows you to zoom in and out of a graph’s plot area via its axes. Once you zoom in on an axis, you can scroll the axis. When you zoom an axis, a zoom and scroll slider appears.

b. Select **left** from the **Legend** location drop-down list. The dialog box should look like this:
**Note:** The "Animate graph on Display" checkbox specifies whether to show initial rendering effects and is selected by default. For example, the bars on a horizontal graph start at the $x$-axis and move up the scale on the $x$-axis to the current measurement level.

"Listen to Master-Detail Events" allows you to specify this analysis as a detail view in a master-detail relationship. You will use this option in a subsequent step when working with pivot tables.

a. Click the Style tabbed page.
b. Click the **Style** drop-down list for Graph Data and select **Gradient**. The Graph Data area allows you to choose a style for specific types of graphs. For example, you might choose pattern fill for to highlight differences on a line-bar graph or gradient for a bar graph to make the data values standout.

Click the **Background** drop-down list in the Plot area, and select a **light blue color** from the Color Selector and click **OK**.
The Graph properties dialog box should look like this:
Click the Scale tabbed page. The Scale tabbed page appears.
Specifically setting axis limits and tick marks allows you to control what you see on your graph. If you override the system default for tick marks, the colors that you have selected for horizontal and vertical gridlines on the General properties tabbed page will be applied to both major and minor ticks.

a. Click the **Titles and Labels** tabbed page.
b. Deselect the checkbox for **Use measure name as graph title** and enter **Regional Revenue** in the Title text box.

c. Click the **Format Title** icon for Graph Title.
The “Font Format: Title” dialog box appears. You use this dialog box to specify how titles, legend labels, and so on are handled (such as truncated automatically) and to specify font properties.

Deselect the check box for **Vertical Axis Title** and click **OK** to close the Graph Properties dialog box.

The preview pane refreshes and should look like this:
Examine the changes that you made to the graph. The formatting changes have been applied along with a new title and a horizontal zoom.

Click the **Zoom** icon and select **Zoom In**.

Once you have zoomed in, a slider appears.
a. In the Layout pane, move **C50 Region** from the Vary Color By drop target to the Graph Prompts drop target. The preview pane refreshes:

The prompt allows you to select each region individually, making the graph a bit easier to consume.

b. Move **C50 Region** to the Sections area and select the **Display as Slider** checkbox. The Graph editor should look like this:
When you move along the slider for a particular region, the graph changes accordingly.

c. Click **Done** and then save your analysis.

You can further experiment with the region slider by clicking the C50 Region or Americas link.

The graph display changes accordingly.
Working with Pivot Tables, and Master-Detail Linking

In this topic, you learn how to create an analysis with a Pivot Table view, format and add a calculation to a pivot table, and create a master-detail linking.

Creating an Analysis with a Pivot Table View

In this subtopic, you begin by creating a new analysis with hierarchical columns and apply selection steps.

To create an analysis with a pivot table, perform the following steps:

Click New > Analysis on the global header. Select A – Sample Sales as the subject area.

In the Analysis Editor, double-click the following columns:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products</td>
<td>Products Hierarchy</td>
</tr>
<tr>
<td>Time</td>
<td>Time Hierarchy</td>
</tr>
</tbody>
</table>
Click the **Results** tab. Two views appear: Title and Pivot Table. Because you are using hierarchical columns, a Pivot Table view is generated automatically.

Expand **Time Hierarchy**.
a. Delete the Title view.

b. Scroll down to view the Selection Steps pane. Expand it.

Note: If you do not see the Selection Steps pane, click the Show/Hide Selection Steps pane icon.
You will add members based on Hierarchy for **Products Hierarchy**.

a. In the **Products - Products Hierarchy** section, click “Then, New Step.”
b. Select “Select Members based on Hierarchy”.

The New Hierarchy Selection step dialog box appears.
Select “Based on Family Relationship” from the Relationship drop-down list.

The New Hierarchy Selection Step dialog box expands.

Select “Keep only”, “Siblings Of” as the action, and then expand Total Products and select FunPod. Move FunPod to the Selected pane.
Click OK.

Save the analysis as **My Selection Steps Analysis** under the folder **My Folders>Regional Revenue**.

Observe that the analysis only shows **BizTech** and **HomeView**, since you selected **Siblings of FunPod**.

Click the pencil icon in Step 2 to edit the selection for **Product Hierarchy**.

In the Edit Hierarchy Selection Step dialog box, select **Include selected members**. Click OK and save the analysis.
Observe that FunPod is included this time.

Selection Steps are now available just as another view that can be included.

From the New View drop-down list, select Selection Steps.
The Selection Steps view is displayed in the compound layout.

Save the analysis.

Now, you will add a Group for Products Hierarchy.

In the **Product – Product Hierarchy** section, click “Then, New Step.”
Select **Add Groups or Calculated Items > New Group**.

In the New Group dialog box, enter **My Group** in the Display Label text box, expand **Total Product**, and then select FunPod and HomeView. Move them to the Selected pane and click **OK**.

This new group is added to the Compound Layout view.
Click **My Group** in the Selection Steps View and select **Edit Group** from the menu.

You will now be able to see and edit the values in **My Group**.
You can also see the values if you expand the **My Group** in the Pivot table.

You can also add **My Group** to all other views in addition to the current pivot table of the analysis.

Save the analysis.

This concludes the topic of creating a Pivot table and applying selection steps to the table.
Formatting a Pivot Table and Adding Calculations

In this subtopic, you begin by creating a new analysis with a hierarchical column and apply a named filter, gauges and a few formatting. Also you will add totals. Pivot tables provide the ability to rotate rows, columns, and section headings to obtain different perspectives of the same data. They are interactive in that they are drillable, expandable, and navigable. The next steps review some features of pivot tables.

To create an analysis with a pivot table, perform the following steps:

Click **New > Analysis** on the global header.

Select **A – Sample Sales** as the subject area.

In the Analysis Editor, add the following columns to the analysis criteria:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orders</td>
<td>Orders Hierarchy</td>
</tr>
<tr>
<td>Customers</td>
<td>C50 Region</td>
</tr>
<tr>
<td>Products</td>
<td>P4 Brand</td>
</tr>
<tr>
<td>Base Facts</td>
<td>1-Revenue</td>
</tr>
</tbody>
</table>

Click the **Results** tabbed page to view the analysis and inspect the pivot table. Observe that the Pivot Table view is included by default.
a. Return to the Criteria tabbed page.

b. Apply the Americas and EMEA named filter as you did previously.

c. Edit the column properties for Revenue. Click the More Options icon for 1 - Revenue and select Column Properties.

The Column Properties dialog box appears.

a. Select the Column Format tabbed page.

b. Select the Custom Headings checkbox and enter Revenue in the Column Heading text box.
a. Select the **Data Format** tabbed page.

b. Select the **Override Default Data Format** checkbox and select the values as indicated below in the image.
c. Click **OK**.

Click the Results tabbed page. Review the formatting changes that you made to the Revenue column.
Click on icon to expand Orders Hierarchy.

<table>
<thead>
<tr>
<th>Orders Hierarchy</th>
<th>C50 Region</th>
<th>P4 Brand</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; Total Orders</td>
<td>AMERICAS</td>
<td>BizTech</td>
<td>$7,768,703.67</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FunPod</td>
<td>$6,317,107.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HomeView</td>
<td>$4,031,183.29</td>
</tr>
<tr>
<td>EMEA</td>
<td>BizTech</td>
<td></td>
<td>$7,846,665.71</td>
</tr>
<tr>
<td></td>
<td>FunPod</td>
<td></td>
<td>$6,663,415.81</td>
</tr>
<tr>
<td></td>
<td>HomeView</td>
<td></td>
<td>$4,483,830.70</td>
</tr>
</tbody>
</table>
If required, you can place **Total Orders** at the bottom of the hierarchy.

a. Click the **Analysis Properties** icon.
b. Go to Data tab in the Analysis Properties window and select Parent values after children.
c. Click OK.
Notice **Total Orders** has moved to the bottom of the hierarchy.

Go back to **Analysis Properties** window and revert the changes.

Delete the **Title** view and then click the Edit View icon to format the pivot table.

The Pivot Table editor appears.

Format the pivot table as follows:

a. Drag **P4 Brand** below Measure Labels.

b. Drag **C50 Region** to the Sections area.

The pivot table should look like this:

Next, you add a calculation to the pivot table by duplicating the **Revenue** column. Click the **More Options** icon for the **Revenue** column and select **Duplicate Layer**.
The duplicated Revenue column appears.

a. Click More Options > Format Headings to edit the properties for the duplicate column.
b. In the **Caption** text entry box in the Edit Format dialog box, name the new column **% Revenue** and click **OK**.
a. Change the calculation to reflect a percentage of the parent. Click **More Options > Show Data As > Percent of > Row Parent**.

The Pivot Table editor looks like this:

![Pivot Table Editor](image1.png)

Click **Done** and save the analysis as **Regional Revenue Pivot**. The pivot table should look like this:

![Regional Revenue Pivot](image2.png)
a. Expand the Orders Hierarchy by clicking the carat sign icon for Total Orders for the Americas. The carat icons are used to expand and collapse the data for analysis. Orders Hierarchy contains Orders on the row edge and Total Orders as the parent. Revenue is the measure.

Because hierarchical columns imply pivot tables, you are able to not only sort on members and measures, but on rows. Hierarchical members on the row edge can include sort carat icons, which allow you to sort the members on the column edge by that row, in either ascending or descending order. These carat icons do not appear for attribute columns, which do not have the concept of a row edge.

When you sort members in a hierarchical column, you always sort within the parent; that is, children are never sorted outside of their parent. The children appear below the parent in the proper sort order; the parent is not sorted within its children.

b. The Total Orders parent member represents an outline total for the orders. Row sort Total Orders, for the Americas in Descending sequence and examine the results within the pivot table.
The product brands on the column edge are sorted, reflecting sorted Revenue values in ascending sequence for each Total Order.

Expand **Express** orders and then expand **6 - Cancelled** to view the % of total revenue lost from cancellations.
a. Place your cursor on top of the Orders Hierarchy and right-click. Select **Collapse all items in view** from the menu. Notice that you can also sort, exclude columns, and move items around using this menu.
b. Place your cursor to the left of the **Brand** column (BizTech). A tab appears. When you hover over this tab, a swap icon appears. You use this swap icon to swap columns with rows or to reposition a column or row along a different axis.

The swap icon looks like this:

![Swap Icon Example](image)

C. Drag **Brand** on top of Orders Hierarchy.
d. Release the mouse button and review the pivot table.

<table>
<thead>
<tr>
<th></th>
<th>AMERICAS</th>
<th>EMEA</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Revenue</td>
<td>% Revenue</td>
</tr>
<tr>
<td>P4 Brand</td>
<td>$7,768,708.67</td>
<td>42.9%</td>
</tr>
<tr>
<td>BizTech</td>
<td>$6,317,107.29</td>
<td>34.9%</td>
</tr>
<tr>
<td>FunPod</td>
<td>$4,031,188.29</td>
<td>22.3%</td>
</tr>
</tbody>
</table>

e. Save the analysis.

Add a gauge view to this pivot table.

a. Click the **New View** icon and select **Gauge > Default (Dial)**.

b. View the gauge
c. Edit the gauge properties to display medium size and remove the footers. Use the pencil icon to access gauge editor. The gauge view should look like this.
Add a slider to the gauge (for C50 Region).

In the Layout pane, drag **C50 Region** to the **Sections** drop target and select **Display as Slider**.

Click **Done** and save the analysis.
Creating a Master-Detail Linking

Master-detail linking of views allows you to establish a relationship between two or more views such that one view, called the master view, will drive data changes in one or more other views, called detail views. To create a Master-Detail linking, for the previously created Regional Revenue Pivot analysis perform the following steps:

Set up the master view to which you link the detail view.

a. Edit Regional Revenue Pivot analysis, select the Criteria tabbed page.

b. Click the More Options icon and select Column Properties for the C50 Region column.

The Column Properties dialog box appears. Go to Interaction tab.
In the Value area, click the **Primary Interaction** drop-down list, and select **Send Master-Detail Events**.

When "**Send Master-Detail Events**" is selected, a qualification text box, **Specify channel**, appears. You use this text box to enter a name for the channel to which the master view will send master-detail events. This is a **case sensitive** text box.
a. Enter region in the "Specify channel" text box and click OK.

b. Save the analysis.

Define the detail view to which the master view should link. You can add any view that includes the same master column as the master view.

a. Click the Results tabbed page to view the Compound Layout and click Edit View for the Gauge view.
b. The Gauge editor appears. Click **Edit gauge properties** on the toolbar.
The Gauge Properties dialog box appears.

a. Select the **Listen to Master-Detail Events** checkbox.
b. Enter region in the Event Channels text box. Remember that this must match precisely with the text entered for the master view.

c. Click OK.

Click Done and then save your analysis.

a. In the Pivot Table view (the master view), select AMERICAS to drill down.
### AMERICAS

<table>
<thead>
<tr>
<th>Product</th>
<th>Revenue</th>
<th>% Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>P4 Brand</td>
<td>$7,768,708.67</td>
<td>42.9%</td>
</tr>
<tr>
<td>BizTech</td>
<td>$6,317,107.29</td>
<td>34.9%</td>
</tr>
<tr>
<td>FunPod</td>
<td>$4,031,188.29</td>
<td>22.3%</td>
</tr>
</tbody>
</table>

### EMEA

<table>
<thead>
<tr>
<th>Product</th>
<th>Revenue</th>
<th>% Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>P4 Brand</td>
<td>$7,846,665.71</td>
<td>41.3%</td>
</tr>
<tr>
<td>BizTech</td>
<td>$6,663,416.81</td>
<td>35.1%</td>
</tr>
<tr>
<td>HomeView</td>
<td>$4,483,830.70</td>
<td>23.6%</td>
</tr>
</tbody>
</table>

### Gauge

- **AMERICAS**
- **EMEA**

Revenue Scale:
- 0% - 33%
- 33% - 67%
- 67% - 100%
Both the Pivot Table view and the Gauge view (the detail view) update to reflect the drill.
b. Save your analysis.

**Adding Performance Tile to an Analysis**

In this topic you learn how to add a performance tile view to your analysis. Purpose of performance tile is to draw your attention to a single piece of high-level aggregate data in a simple and prominent manner.

Create a new analysis. Click **New > Analysis** on the global header. Use **A - Sample Sales** Subject Area.
In the Analysis Editor, double-click the following columns:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Facts</td>
<td>1 - Revenue</td>
</tr>
<tr>
<td>Base Facts</td>
<td>5 - Target Revenue</td>
</tr>
</tbody>
</table>

Click the Results tab. Click the New View icon and select Performance Tile.
View the performance tile. By default, the first measure in the analysis on the criteria tab is selected as the performance tile measure.

Click on pencil icon to go to edit window of performance tile.
Do the following formatting changes:

- Modify the Name and Description Labels
- Modify the style

Modify the background color of the performance tile.
Click OK.

Similarly create one more performance tile for measure: 5 - Target Revenue.
Remove title and table views. Place both the performance tiles side by side.

Thus, performance tile gives a clear snapshot of whether the actual revenue is more than the target revenue or not.

Save as **Performance Tile Analysis**.

**Adding a Simple Trellis to an Analysis**

In this topic you learn how to add a simple trellis to your analysis. Trellis is like 'Grid of Charts' that displays a matrix of measure over multiple dimensions with each cell in the matrix containing a micro chart, showing for example revenue in each product brand and territory graph over time.

Create a new analysis using the New>Analysis on the global header, and then selecting **A-Sample Sales** as the subject area.
In the Criteria tab, select the following columns:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>T05 Per Name Year</td>
</tr>
<tr>
<td>Products</td>
<td>P4 Brand</td>
</tr>
<tr>
<td>Customers</td>
<td>C50 Region</td>
</tr>
<tr>
<td>Base Facts</td>
<td>1-Revenue</td>
</tr>
</tbody>
</table>

Click the **Results** tab. Two views **Title** and **Table** appear.
Add the Trellis view. Click **New View>Trellis>Simple.**
Scroll down to view the **Trellis** view.
Delete both the Title and Table views. Move C50 Region from column to row side.
Save the analysis as My Trellis View, under the folder My Folders/Regional Revenue
Click the **Edit View** pencil icon in the Trellis view at the Compound Layout. Note that the layout pane appears vertical.
Arrange the dimensions and measure as shown below:
Click Done.

The Trellis view appears. Observe that the measure has the same scale for all the Brands.
This concludes the topic of creating a Simple Trellis view.

Working with Other View Types

You have learned about creating the following views:

- Title
- Table
- Pivot Table
- Graph
- Gauge
- Performance Tile
- Trellis

In this topic, you will create a Narrative view, a Column Selector view and a View Selector view.

Creating a Narrative View

You create a Narrative view to provide information such as context, explanatory text, or extended descriptions along with column values for an analysis. You can include values from attribute, hierarchical, and measure columns. If you want to include hierarchy levels in a Narrative view, use selection steps to display the levels. The Narrative view is a combination of text and query column values.

To add a Narrative view, perform the following steps:

To create a meaningful Narrative view, begin by creating a new analysis that includes a calculated item.

a. Create an analysis as you did above, including the following columns:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customers</td>
<td>C50 Region</td>
</tr>
<tr>
<td>Customers</td>
<td>C0 Customer Number</td>
</tr>
<tr>
<td>Customers</td>
<td>C1 Customer Name</td>
</tr>
<tr>
<td>Base Facts</td>
<td>4-Paid Amount</td>
</tr>
<tr>
<td>Base Facts</td>
<td>3-Discount Amount</td>
</tr>
</tbody>
</table>
b. Change the properties of 4 - Paid Amount and 3 - Discount Amount to include dollar signs, commas, and two decimal places. The properties should look like this:

c. Add a filter to C50 Region and select only Americas region and save the filter as AMERICAS only.
a. Add **Discount Amount** to the Criteria tabbed page a second time. The Selected Columns within the Criteria tabbed page should look like this:

![Selected Columns example](image)

b. Edit the Column Properties for the duplicate **Discount Amount** column. Click **More Options** for this duplicate column and select **Column Properties**.

![Column Properties example](image)

c. Select the **Column Format** tabbed page, and select the checkbox for **Custom Headings**. Enter **Discnt Pct to Paid Amt** in the Column Heading text box.
d. Using the Data Format tabbed page, format the data for this column as a percentage with two decimal places and then click **OK**.
The Selected Columns should look like this:

![Column Properties]

- Click **More Options** for Discnt Pct to Paid Amt and select **Edit Formula**.
b. Enter the following formula into the Column Formula text box.

("Base Facts"."3- Discount Amount"/"Base Facts"."4- Paid Amount")*100

**Hint:** You can copy the line of code and paste it into the Column Formula text box.

The Edit Column Formula dialog box should look like this:
c. Click **OK**.

a. Select the **Results** tabbed page and remove the Title view from the Compound Layout.

b. Click the **Edit View** icon to open the Table editor.
c. Click the **More Options** icon for C50 Region and select **Hidden** to hide the column.

d. Click **Done** to review your results. The Table view should look like this:
e. Save the analysis as **Customer Discounts by Region**.

To add the Narrative view perform the following steps:

a. Click the **New View** icon on the toolbar and select **Other Views > Narrative**.
b. Drag the Narrative view above the Table view.

c. Click the **Edit View** icon for the Narrative view.
The Narrative editor appears.

- You use the Prefix text box to enter the header for the narrative. This text is displayed at the beginning of the narrative.
- You use the Narrative text box to enter the narrative text that will appear for each row in the results. You can include both text and column values. Include a line break code at the end of this field to force each line of text and values onto its own line. To include values, use the at sign (@) by itself to indicate the first column. If you include multiple signs, then the first occurrence of the sign corresponds to the first column, the second occurrence corresponds to the second column, and so on. You use the @ sign to include the results from the designated column in the narrative.
- You use the “Row separator” text box to enter a row separator for each line from the Narrative field that contains values. For example you might enter a string of plus signs (+) between each line.
- You use the “Rows to display” text box to enter the number of rows from the column to return. For example, enter 5 to display values from the first 5 rows of the column. For a hierarchical column, you can use selection steps to display hierarchy levels with the hierarchical column. A hierarchy level is considered a row.
- You use the Postfix text box to enter the footer text to appear at the bottom of the narrative. To display the footer information on a separate line from the actual narrative text, include markup tags in the Postfix field. Ensure that the narrative ends in a line break, or that the footer begins with a line break.
- The toolbar allows you to use HTML code and markup to enhance the narrative.

b. In the Prefix text box, enter **This analysis shows the discount percentage for each customer within the**, ensuring that you leave a single space following the last word.
c. In the Narrative text box, enter @1, where the number “1” represents the first column in the analysis (C50 Region). Then, select the @1 that you entered and click the bold icon.

d. In the Postfix text box, enter region, ensuring that you include a space before region and period after region.

e. Enter 1 in the "Rows to display" text box.

Notice that a preview is provided at the bottom of the editor.

Click Done and save your analysis. The Compound Layout should look like this:
Creating Column Selector and View Selector Views

A Column Selector view adds a column selector to the results. A column selector is a drop-down list from which users can dynamically change the columns that display in results. This will allow you to analyze data along several dimensions. By changing the measure columns, you can dynamically alter the content of the analyses you have created.

To create a Column Selector and View Selector views, perform the following steps:

a. Open the Regional Revenue analysis in the Analysis Editor. The Results tabbed page appears.

This concludes the topic creating a narrative view.
<table>
<thead>
<tr>
<th>Region</th>
<th>P1 Product</th>
<th>1- Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMERICAS</td>
<td>7 Megapixel Digital Camera</td>
<td>1,293,069</td>
</tr>
<tr>
<td></td>
<td>Bluetooth Adaptor</td>
<td>671,988</td>
</tr>
<tr>
<td></td>
<td>CompCell RX3</td>
<td>839,407</td>
</tr>
<tr>
<td></td>
<td>Game Station</td>
<td>1,054,701</td>
</tr>
<tr>
<td></td>
<td>HomeCoach 2000</td>
<td>689,154</td>
</tr>
<tr>
<td></td>
<td>KeyMax S-Phone</td>
<td>906,918</td>
</tr>
<tr>
<td></td>
<td>LCD 36X Standard</td>
<td>1,364,184</td>
</tr>
<tr>
<td></td>
<td>LCD HD Television</td>
<td>523,207</td>
</tr>
<tr>
<td></td>
<td>MP3 Speakers System</td>
<td>375,816</td>
</tr>
<tr>
<td></td>
<td>MPEG4 Camcorder</td>
<td>1,340,402</td>
</tr>
<tr>
<td></td>
<td>MaxiFun 2000</td>
<td>821,081</td>
</tr>
<tr>
<td></td>
<td>MicroPod 60gb</td>
<td>1,828,738</td>
</tr>
<tr>
<td></td>
<td>Plasma HD Television</td>
<td>372,097</td>
</tr>
<tr>
<td></td>
<td>PocketFun ES</td>
<td>1,118,700</td>
</tr>
<tr>
<td></td>
<td>SoundX Nano 4Gb</td>
<td>875,679</td>
</tr>
<tr>
<td></td>
<td>Touch-Screen T5</td>
<td>991,342</td>
</tr>
<tr>
<td></td>
<td>Tungsten E Plasma TV</td>
<td>1,374,338</td>
</tr>
<tr>
<td></td>
<td>V5x Flip Phone</td>
<td>1,275,820</td>
</tr>
<tr>
<td><strong>AMERICAS Total</strong></td>
<td><strong>17,719,642</strong></td>
<td></td>
</tr>
<tr>
<td>EMEA</td>
<td>7 Megapixel Digital Camera</td>
<td>1,412,995</td>
</tr>
<tr>
<td></td>
<td>Bluetooth Adaptor</td>
<td>617,591</td>
</tr>
<tr>
<td></td>
<td>CompCell RX3</td>
<td>856,744</td>
</tr>
<tr>
<td></td>
<td>Game Station</td>
<td>1,072,950</td>
</tr>
<tr>
<td></td>
<td>HomeCoach 2000</td>
<td>655,218</td>
</tr>
<tr>
<td></td>
<td>KeyMax S-Phone</td>
<td>858,810</td>
</tr>
</tbody>
</table>

b. Click the **New View** icon and select **Other Views > Column Selector**.
The Column Selector view appears. Drag the Column Selector view above the Title view.
Click the **Edit View** icon for the Column Selector view. The Column Selector editor appears.

![Column Selector](image)

**a.** Select the **Include Selector C50 Region** checkbox.

![Column Selector](image)

**b.** In the Label (optional) Choices text box, enter **Choose a column:**.

**c.** With Column still selected, double-click the following columns to add to the selector: **P4 Brand**, **P3 LOB**, and **P2 Product Type**.

![Column Selector](image)

**d.** Click **Done**.

The Compound Layout appears:
a. Click the Column Selector drop-down list and select P3 LOB:
b. The values change appropriately. Note, because you have set a custom heading for the **C50 Region** column earlier, the custom heading is still displayed for the column.
c. Save the analysis.

Now you will add the View Selector view.

A View Selector view provides a drop-down list from which users can select a specific view of analysis results from among saved views. A View Selector view is analogous to a storage container, in that it holds other views which have been selected in the editor for display.

a. Perform these steps before adding the View Selector view:

- Delete the Title view from the Compound Layout.
- Set the Column Selector to display the C50 Region column, the default. Then delete the Column Selector view from the Compound Layout.
### Compound Layout

<table>
<thead>
<tr>
<th>Region</th>
<th>P1 Product</th>
<th>1- Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMERICAS</td>
<td>7 Megapixel Digital Camera</td>
<td>1,293,069</td>
</tr>
<tr>
<td></td>
<td>Bluetooth Adaptor</td>
<td>671,988</td>
</tr>
<tr>
<td></td>
<td>CompCell RX3</td>
<td>835,407</td>
</tr>
<tr>
<td></td>
<td>Game Station</td>
<td>1,054,701</td>
</tr>
<tr>
<td></td>
<td>HomeCoach 2000</td>
<td>689,154</td>
</tr>
<tr>
<td></td>
<td>KeyMax S Phone</td>
<td>906,918</td>
</tr>
<tr>
<td></td>
<td>LCD 36X Standard</td>
<td>1,364,184</td>
</tr>
<tr>
<td></td>
<td>LCD HD Television</td>
<td>523,207</td>
</tr>
<tr>
<td></td>
<td>MP3 Speakers System</td>
<td>376,816</td>
</tr>
<tr>
<td></td>
<td>MPEG+ Camcorder</td>
<td>1,340,402</td>
</tr>
<tr>
<td></td>
<td>MaxiFun 2000</td>
<td>821,081</td>
</tr>
<tr>
<td></td>
<td>MicroPod 60Gb</td>
<td>1,828,738</td>
</tr>
<tr>
<td></td>
<td>Plasma HD Television</td>
<td>372,097</td>
</tr>
<tr>
<td></td>
<td>PocketFun ES</td>
<td>1,118,700</td>
</tr>
<tr>
<td></td>
<td>SoundX Nano 4Gb</td>
<td>876,679</td>
</tr>
<tr>
<td></td>
<td>Touch-Screen T5</td>
<td>991,342</td>
</tr>
<tr>
<td></td>
<td>Tungsten E Plasma TV</td>
<td>1,374,338</td>
</tr>
<tr>
<td></td>
<td>V5x Flip Phone</td>
<td>1,276,820</td>
</tr>
</tbody>
</table>

**AMERICAS Total** 17,719,642

<table>
<thead>
<tr>
<th>EMEA</th>
<th>7 Megapixel Digital Camera</th>
<th>1,412,995</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bluetooth Adaptor</td>
<td>617,591</td>
</tr>
<tr>
<td></td>
<td>CompCell RX3</td>
<td>856,744</td>
</tr>
<tr>
<td></td>
<td>Game Station</td>
<td>1,072,950</td>
</tr>
<tr>
<td></td>
<td>HomeCoach 2000</td>
<td>655,218</td>
</tr>
<tr>
<td></td>
<td>KeyMax S-Phone</td>
<td>858,810</td>
</tr>
</tbody>
</table>

- Add a Graph view - Vertical Bar graph.
These changes will allow you to showcase the analytic data-driven views. Regional Revenue should look like this:
a. Click the **New View** icon on the toolbar and select **Other Views > View Selector**.
b. Drag the View Selector view to the right of the Table view.
c. Click the **Edit View** icon for the View Selector view.

a. The View Selector editor appears. In the Caption text box, enter *Choose a view:*

b. In the **Available Views** list, select the **Table** and **Graph** views and click the shuttle icon to move them to the **Views Included** list.
A preview appears at the bottom of the editor. Note that these views are data-driven views, unlike the Column Selector and Title views, which were deleted from the Compound Layout.
c. Click Done.

The Compound Layout should look like this when the Graph view is selected:
Building Dashboards

In this topic, you will learn about My Dashboard view and how to create and edit a shared dashboard, adding a saved analysis that you have created previously. Dashboards provide personalized views of corporate and external information. Based on your permissions, you can view pre configured dashboards or create your own personalized views. Users with administrative privileges can create shared dashboards for groups of users with common responsibilities or job functions. The ability to create and edit dashboards is controlled by the Manage Dashboard privilege, which is managed by the administrator.

You can view your personalized views by selecting My Dashboard from the Dashboards drop-down list. You can also set My Dashboard as your default dashboard. Pre configured dashboards appear in the Dashboards drop-down list. They can be created by administrators and shared with groups of users with common responsibilities or job functions.

Exploring and Editing My Dashboard

My Dashboard, a personalized view, is a dashboard page that you create and save as your default, personal starting page by using the My Account dialog box, Preferences tabbed page. To open My Dashboard, perform the following steps:

Click the Dashboards link on the global header and then click My Dashboard.
An empty My Dashboard page appears.

When you open a dashboard, including My Dashboard, the content appears in one or more dashboard tabbed pages. Pages contain the columns and sections that hold the content of a dashboard, and every dashboard has at least one page. Multiple pages are used to organize content.

This example shows an empty My Dashboard page with no content. Hover over the Edit icon to edit the dashboard and add content.

**Note:** If you have chosen or if your company has setup My Dashboard as your default, then you use dashboard template pages to populate your personal dashboards (My Dashboard) when you first log in as a new user. This allows you to see one or more dashboard pages with content, rather than an empty dashboard. It also gives you a starting point to build your own dashboard pages.

Click the **Edit** icon to add content to your empty dashboard page.

The Dashboard Builder appears and automatically creates **page 1** of your dashboard (the first tabbed page).
Using the Dashboard Builder, you can add pages and objects to a dashboard and control the page layout. The Dashboard Builder is composed of the following:

- **Dashboard Toolbar**: The toolbar allows you to perform tasks such as adding or deleting pages, previewing, saving, and so on.
- **Dashboard Objects pane**: Items that are used only in a dashboard. Examples of dashboard objects are sections to hold content, action links, and embedded content that is displayed in a frame on a dashboard.
- **Catalog pane**: Items that you or someone else has saved to the Catalog, for example, analyses, prompts, and so on. In a dashboard, the results of an analysis can be shown in various views, such as a table, graph, and gauge. (The results of an analysis are the output that is returned from the Oracle BI Server that matches the analysis criteria.) Users can examine and analyze results, save or print them, or download them to a spreadsheet.
- **Page Layout pane**: This is a workspace that holds your objects, which are displayed on the dashboard.

In the Dashboard Toolbar, the Tools toolbar button provides options to set dashboard properties, set page report links, and so on.

As mentioned above, the Dashboard Objects pane provides you with a list of objects to add as content to a dashboard page. You will have to drag the object to the Page Layout pane on the right.
- **Columns** are used to align content on a dashboard. (Sections within columns hold the actual content.) You can create as many columns on a dashboard page as you need.
- **Sections** are used within columns to hold the content, such as action links, analyses, and so on. You can drag and drop as many sections as you need to a column.
- **Alert Section** is used to add a section in which you display Alerts from Agents, if any. (Agents dynamically detect information-based problems and opportunities, determine the appropriate individuals to notify, and deliver information to them through a wide range of devices such as e-mail, phones, dashboard alerts, and so on.) An Alert section is added by default to the first page of My Dashboard if you do not manually include one. You cannot disable the appearance of an Alert section on the first page of My Dashboard. You can add an Alert section to an additional dashboard page so that section will then appear on both dashboard pages.

Drag the **Column** object onto the Page Layout pane.

The Column object appears on the Page Layout pane.
a. In the Catalog pane, navigate to the folder where you saved your analysis.

b. Drag the **Regional Revenue Graph** analysis to the **Column 1**.
Regional Revenue Graph appears in the column. Observe that a **Section** is automatically created for you. You can also drag an analysis directly onto an empty Layout Pane without first creating a column. The Dashboard Builder automatically creates the column for you. You can then add sections automatically to that column by dragging analyses below the existing sections.

c. Click the **Save** icon ( ) to save the dashboard page and then click the **Run** icon.

My Dashboard appears with the selected analysis **Regional Revenue**.
Creating a Dashboard

To create a new dashboard, perform the following steps:

Click the **New > Dashboard** in the global header.
The New Dashboard dialog box appears.

A. Enter Customer Detail in the name text box. Notice that you can also enter a description of your choice.

B. Navigate to your Regional Revenue folder and select it as the Location. If you receive a warning message, click OK to close it.
Note: If you save the dashboard in the Dashboards sub folder directly under /Shared Folders/first level sub folder, the dashboard will be listed in the Dashboard menu on the global header. If you save it in a Dashboards sub folder at any other level (such as /Shared Folders/Sales/Eastern), it will not be listed. If you choose a folder in the Dashboards sub folder directly under /Shared Folders/first level sub folder in which no dashboards have been saved, then a new Dashboards folder is automatically created for you. For example, if you choose a folder named /Shared Folders/Sales in which no dashboards have been saved, a new Dashboards folder is automatically created and the Location entry changes to /Shared Folders/Sales/Dashboards. A new Dashboards folder is not automatically created if you choose a folder at any other level.

c. Accept the default to Add content now. The New Dashboard dialog box should look like this:

![New Dashboard dialog box](image)

Note: A Dashboards sub folder will be automatically created inside the Regional Revenue folder where this new dashboard will be placed.

d. Click OK. The Dashboard Builder appears.

![Dashboard Builder](image)
a. Navigate to the **Customer Discounts by Region** analysis and drag it from the Catalog to the Page Layout pane.

b. Save and run the dashboard. The Customer Detail dashboard appears.
As mentioned above, because this dashboard was not created in a Dashboards sub folder directly under /Shared Folders/first level sub folder, the dashboard will not be listed in the Dashboard menu on the global header. To open the dashboard, navigate to it in the Catalog, or open it from the Recent list on the Home page or in the global header’s Open menu.

**Editing a Dashboard**

Dashboard editing, which is performed by using the Dashboard Builder as evidenced above, is allowed for users with the appropriate privileges. In this subtopic, you enhance My Dashboard.
To begin enhancing My Dashboard, perform the following steps:

a. Click **Dashboards > My Dashboard**.

b. Click the **Page Options** icon ( ) and select **Edit Dashboard**.

Give the existing tabbed page a more meaningful name.

Click the **Tools** button and select **Dashboard Properties**.

The **Dashboard Properties** dialog box appears.
From this dialog box, you can do the following:

- Change the Styles—Styles control how dashboards and results are formatted for display, such as the color of text and links, the font and size of text, the borders in tables, the colors and attributes of graphs, and so on
- Add a description—Descriptions are displayed when Oracle BI Administrators use the Catalog Manager
- Add hidden prompts, filters, and variables
- Specify the links that will display with analyses on a dashboard page
- Rename, hide, reorder, set permissions for, and delete dashboard pages

Select page 1 in the Dashboard Pages section. The Dashboard Page Control toolbar is enabled. Using the toolbar, you can do the following:
- Change the name of your dashboard page.
- Add a hidden prompt. Hidden prompts are used to set default values for all corresponding prompts on a dashboard page.
- Add permissions for the dashboard.
- Delete the selected page. Dashboard pages are permanently deleted.
- If more than one dashboard pages are in this dashboard, the arrange order icons are enabled (up and down arrow icons).

```
Rename

Name: page 1

[ ] Preserve references to old name of this item.

OK Cancel
```

**a.** Click **Rename** icon ( Rename Icon ). The **Rename** dialog box appears.

**b.** Enter **Regional Revenue** in the Name text box and click **OK**.

```
Rename

Name: Regional Revenue

[ ] Preserve references to old name of this item.

OK Cancel
```

The Dashboard Properties dialog box reappears with the new dashboard page name.
a. Click the the **Edit icon** for **Dashboard Report Links** to set the report links at the dashboard level. Report links can be set at the dashboard, dashboard page (click Page Options> Page Report Links), or analysis level (click the properties icon for the specific analysis within the Dashboard Builder and then select Report Links).
b. Select the checkboxes as indicated in the image below. Click **OK** and then click **OK** again to return to the Dashboard Builder.
The Dashboard Builder should look like this:

![Dashboard Builder Screenshot](image1.png)

**a. Go to Dashboard Objects pane, drag and drop a new column just above the existing column in the Page Layout pane.**

![Column Drag and Drop Screenshot](image2.png)
b. In the Catalog pane, navigate to the Performance Tile Analysis and drag it to the Page Layout pane on the right.

c. In this release, you can freeze a column at an edge (top or left) of a dashboard page layout. Click the Column Properties icon and select Freeze Column. As in this dashboard, columns are lying one above the other, frozen column will be anchored at the top of the page layout.
d. Click the Save icon (奋力) to save the dashboard page and then click the Run icon (奋力).

My Dashboard appears with the column containing Performance Tile Analysis anchored at the top of the page layout. It will not scroll off the page as you scroll the content in the other column.
a. Go back to Dashboard Builder and click the Add Dashboard Page icon.

b. The Add Dashboard Page dialog box appears. Name the dashboard page Customer Detail and click OK.
In the Catalog pane, navigate to the **Customer Discounts by Region** analysis and drag it to the Page Layout pane on the right.

Edit the properties of the section.

You use the Section Properties drop-down list to do numerous tasks:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format Section:</td>
<td>Use this option to display the Section Properties dialog, where you specify the properties for the section, such as cell alignment and border color.</td>
</tr>
<tr>
<td>Rename:</td>
<td>Use this option to display the Rename dialog box, which allows you to rename the section.</td>
</tr>
<tr>
<td>Drill in Place:</td>
<td>Use this option to specify how the results appear when a user drills in an analysis. If a check mark appears in front of the “Drill in Place” option, the original analysis is replaced when the user drills (the section will automatically resize to fit the new analysis). If the check mark is not present in front of “Drill in Place,” the entire dashboard content is replaced. Use this option for prompts that are created for hierarchical columns.</td>
</tr>
</tbody>
</table>
Collapsible: Use this option to specify whether the user can expand and collapse this section on a dashboard page or whether the section is always expanded. If a check mark appears in front of the Collapsible option, you can expand and collapse the section.

Show Section Header: Use this option to specify whether to display the header for the section, which initially includes the title of the section. You can hide the title using the Show Section Title option.

Show Section Title: Use this option to specify whether to display the title of the section.

When you have more than one analysis within the section, you can also align the analysis by using the vertical and horizontal alignment icons.

a. You can have conditions on the sections. You use conditions to determine: whether sections and their content appear on the dashboard page; agents deliver their content and execute their actions; and action links appear on dashboard pages. Conditions are evaluated based on a Boolean expression; in other words, the condition is either True or False.

Click the Properties drop-down list for the section and select Condition.

The Section Condition dialog box appears.
b. Set a condition that determines whether the analysis appears on the dashboard.

Click the **New Condition** icon ( ). The **New Condition** dialog box appears. Select Analysis to base the new condition from the drop-down list.

Browse the Catalog and select the **Customer Discounts by Region** analysis.

a. In the “True If Row Count” drop-down list, select **is less than** and enter **25** in the text box to the right.

The New Condition dialog box should look like this:
b. Click Test.

Previously, your analysis returned more than 25 records, therefore this test should evaluate to False.

c. Your results are verified. Click OK. To further verify your results, click OK and click OK again to return to the Dashboard Builder.

Preview the dashboard page now.

The dashboard page is empty.

d. Click the Properties drop-down list for the section and select **Condition**. The Section Condition dialog box appears.
e. Click the More icon and select **Remove Condition** to remove the condition so that the section displays.
e. Click the **OK**.

You will rename the section.

a. Click **Properties** (within the section) > Rename. The Rename dialog box appears.

b. Enter **Customer Discount Percentage** in the text box and click the **Properties** icon.

c. Click **OK**.

a. Click **Properties** (within the section) > **Show Section Title**.
b. Preview the dashboard page once again to see your changes.

c. Save the dashboard.

Override the default dashboard report links at the analysis level.

a. Click the Properties icon for the Customer Discounts by Region analysis, and select Report Links.
b. The Report Links dialog box appears.

c. Select the Customize radio button and then select all checkboxes.

d. Click OK.

e. Save and run the dashboard page. You are now able to export and copy this analysis from the dashboard.
a. Open the dashboard in the Dashboard Builder again and further edit the Customer Detail tabbed page.

b. Edit the section properties for the analysis and select Drill in Place. Drilling allows you to view additional levels of detail for the specific column. Drill in Place means that the current browser is refreshed with the new data. To return to the previous view, simply click the back button on your browser.

c. Save and run the dashboard page.

Drill down on Customer Name, Diego Link.

The Customer's Order Status and Order Type columns appear.
This release contains a new feature: Breadcrumbs. Breadcrumbs have been added to help you understand your current location within Oracle BI content and the path that you have used to navigate Oracle BI content.

Observe the bottom left corner of My Dashboard. Breadcrumbs are active links that you can click to return to the place from which you navigated and to the state of the content when you left it.

Blue text in italics indicates links to visited locations. Here it points to My Dashboard: Regional Revenue and Customer Detail pages. Black text indicates your current location in Dashboard Editor.
Saving a Customized Dashboard and Setting Preferences

To save a customized dashboard and set preferences, perform the following steps:

Create a personal, customized view of your dashboard page. Saved customizations allow you to save and view dashboard pages in their current state with your most frequently used or favorite choices for items such as filters, prompts, column sorts, drills in analyses, and section expansion and collapse. By saving customizations, you do not need to make these choices manually each time that you access the dashboard page.

a. Click **Page Options > Save Current Customizations**.

b. The Save Current Customization dialog box appears. Name your customization **Customer Order Status** and click **OK**.

c. You can apply the saved customization to a dashboard page. Click **Page Options > Apply Saved Customization > Customer Order Status**.
Set your preferences. You use the Preferences tabbed page in the My Account dialog box to specify your personal preferences, such as dashboard starting page, locale, and time zone. The available options depend upon your privileges.

**a.** Click your **User ID** on the global header and then select **My Account**.

The My Account dialog box appears.
b. Click the **Starting Page** drop-down list and scroll to view the available pages. Only the dashboard pages to which you have privileges appear in this list. Select the **My Dashboard** as your default.

Other tabbed pages in the **My Account** dialog box include the following:

- **BI Publisher Preferences**—Use this tabbed page to view the default profile for BI Publisher.
- **Delivery Options**—Use this tabbed page to configure your delivery profiles for the delivery of alerts by agents.
- **Roles and Catalog Groups**—Use this tabbed page to view a list of the roles to which you have been assigned by the Oracle BI Administrator.

c. Set the **Locale**, **User Interface Language**, **Time Zone**, **Currency**, and **Accessibility Mode** appropriately for your own needs and click **OK**.

**Note:** The **Analysis Editor** drop-down is a new feature in the current release.

d. Click **OK**.

To verify that your starting page is now set to the My Dashboard dashboard page, log out and log back in. Your start page should look like this:

---

Exporting the Dashboard to Excel Spreadsheet
You can export an entire dashboard or a single dashboard page to Microsoft Excel 2007+.

Click **Page Options > Export to Excel.**

If you choose **Export Entire Dashboard** then all dashboard pages of **My Dashboard** are exported to excel 2007. Choose **Export Current Page** and following window will pop up.

Click **OK.**
Dashboard Page in this case **Regional Revenue**, appears as a worksheet in excel.

Next you will learn how to add prompts and use presentation variables on your dashboard.

**Prompting to Filter Analysis**

A dashboard prompt is a special filter that filters analyses embedded in a dashboard. There are two various prompts and this topic discusses the Named and Inline Prompts. You will learn to create a Named Prompt in your dashboard.

The prompt created at the dashboard level is called a **Named** prompt, because, the prompt is created outside of a specific dashboard and stored in the catalog as a prompt object, which can then be applied to any dashboard or dashboard page that contains the columns, which are specified in the prompt. It can filter one or any number of analysis embedded on the same dashboard page. You can create and save these named prompts to a private folder or a shared folder.

- A named prompt is interactive and will always appear on the dashboard page so that the user can prompt for different values without having to rerun the dashboard.
- A named prompt can also interact with selection steps. You can specify a dashboard prompt to override a specific selection step. The step will be processed against the dashboard column with the user-specified data values collected by the dashboard column prompt, whereas all other steps will be processed as originally specified.

**Inline** prompts, are embedded in an analysis and are not stored in the Catalog for reuse. An Inline prompt provides general filtering of a column within the analysis, and depending on how it is configured, can work
independently from a dashboard filter, which determines values for all matching columns on the dashboard. An inline prompt is an initial prompt. When the user selects the prompt value, the prompt field disappears from the analysis. To select different prompt values, the user must rerun the analysis. The user’s choices determine the content of the analysis embedded in the dashboard.

Creating a Named Dashboard Prompt

Named Dashboard Prompts in the Catalog can be applied to any dashboard or dashboard page that contains the columns specified in the prompt.

Objective is to filter an analysis on the basis of a named dashboard prompt.

Creating a Column prompt

Create an analysis with filters.

a. Create an analysis with the following columns:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>T05 Per Name Year</td>
</tr>
<tr>
<td>Sales Person</td>
<td>E1 Sales Rep Name</td>
</tr>
<tr>
<td>Base Facts</td>
<td>1-Revenue</td>
</tr>
</tbody>
</table>

b. Create filter for T05 Per Name Year and E1 Sales Rep Name. Click the More link for T05 Per Name Year. In the New Filter dialog box, select is prompted as the operators. Click OK.
c. Similarly, create a filter for E1 Sales Rep Name. Your analysis should look like this:

![New Filter dialog]

**Selected Columns**

Double click on column names in the Subject Areas pane to add them to the analysis.

<table>
<thead>
<tr>
<th>Column</th>
<th>Operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>T05 Per Name Year</td>
<td>is prompted</td>
</tr>
<tr>
<td>E1 Sales Rep Name</td>
<td>is prompted</td>
</tr>
</tbody>
</table>

**Filters**

Add filters to the analysis criteria by clicking on the Filter option for the specific column.

- T05 Per Name Year *is prompted*
- E1 Sales Rep Name *is prompted*


d. Save the analysis as **My SalesRep Stats**.

Create a named dashboard prompt for year and SalesRep.

Click **New > Dashboard Prompt** on the global header and then select the A - Sample Sales subject area.
The Definition pane appears. The Definition pane allows you to add, organize, and manage a named prompt's columns. You can use column prompts, image prompts (maps), currency prompts, and variable prompts. The Definition table lets you view high-level information about the prompt's columns. You can also use this table to select columns for editing or deleting, arrange the order in which the prompts appear to the user, or insert row or column breaks between prompt items.

The Display pane is a preview pane that allows you to view the prompt's layout and design.

a. In the Definition pane, click the New prompt icon (➕), and select Column Prompt.
b. Select **T05 Per Name Year** from **Time** folder, and click **OK**.

c. The New Prompt: **T05 Per Name Year** dialog box appears.

The Prompt for Column field allows you to view information about the column that you selected as the prompt. This appears only for column prompts.
The Label text box allows you to enter a meaningful label that appears on the dashboard next to the prompt. Enter **Select a Region:** in the Label text box (add a space following the colon). You can optionally enter a description.

d. Select the operator. Accept the default, "is equal to / is in." This field is only for column prompts.

e. The User Input field's drop-down list appears for column and variable prompts and provides you with the option to determine the User Input method for the user interface—in other words, the user will see one of the following: check boxes, radio buttons, a choice list, or a list box. You use this item in conjunction with the **Choice List Values** item to specify which data values appear for selection. For example, if you selected the User Input method of **Choice List** and the Choice List Values item of **All Column Values**, the user will select the prompt's data value from a list that contains all of the data values contained in the data source.

Accept the default, **Choice List.**

f. The Options section provides you with the opportunity to constrain values available for selection. Expand the Options section. Because you selected **Choice List** for the User Input field, you must now indicate those values. Some of your choices include **All Column Values**, **Specific Column Values** (where you supply those values), SQL Results (choose a list of values based on a SQL statement), and so on.

Accept the default, **All Column Values.**

g. The series of checkboxes allow you to restrict the amount of data returned. Select **Enable user to select multiple values**, and **Require user input**. Allowing multiple selection of values lets you choose more than one value (region for example), and requiring input forces you to enter at least one value. "Default selection" allows you to selection an initial value and "Set a variable" allows you to create a new variable that this column prompt will populate. Accept the default, None, for both of these fields.

The New Prompt dialog box should look like this:
h. Click OK.

The prompt is added to the Definition pane.

Similarly, add another prompt for E1 Sales Rep Name. In the New Filter dialog box, label the prompt as “Sales Rep Name: ”. You should now have two prompts in the Definition page.
Click the row-based layout at the top and notice that the prompts are laid out horizontally.

Save the prompt in the Regional Revenue folder as My prompt.

You can now manage prompts with different options.

- You can choose to show or hide a prompt's apply and reset buttons. If the designer chooses to hide the apply button, then the specified prompt value is immediately applied to the dashboard or analysis.
- Also, the prompt Reset button now provides three reset options: Reset to last applied values, Reset to default values, and Clear All.
The row-based layout prompt option is added to the prompt editor's "Definition pane". You can now display your prompts in a row or in a column.

Test the prompt.

Navigate to My Dashboard and open it in the Dashboard builder. Add a new dashboard page.

Name the new dashboard page as SalesRep Detail.

Navigate to select My SalesRep Stats analysis from the catalog pane and drag it to SalesRep Detail dashboard page.
Navigate to select My Prompt from the catalog pane.

Drag My Prompt to Column 1, above the My SalesRep Stats analysis.
Click the **My Prompt** properties dialog icon and select **Scope Page**. Scope determines whether the prompt applies to the entire dashboard or just this page.

a. Save and run the dashboard. Initially, no filters will be applied. Hence all the data will be displayed.
b. Select 2010 from Year dropdown list.
c. Click **Apply**. ‘T05 Per Name Year’ value changes for this page.

![SalesRep Detail](image)

<table>
<thead>
<tr>
<th>T05 Per Name Year</th>
<th>E1 Sales Rep Name</th>
<th>1- Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010</td>
<td>Angela Richards</td>
<td>4,496,699</td>
</tr>
<tr>
<td></td>
<td>Anne Green</td>
<td>2,861,202</td>
</tr>
<tr>
<td></td>
<td>Aurelio Miranda</td>
<td>868,710</td>
</tr>
<tr>
<td></td>
<td>Bob Grant</td>
<td>1,394,826</td>
</tr>
<tr>
<td></td>
<td>Charles Brooks</td>
<td>1,487,858</td>
</tr>
<tr>
<td></td>
<td>Chris Jones</td>
<td>2,881,775</td>
</tr>
<tr>
<td></td>
<td>Ediberto Mandari</td>
<td>1,393,917</td>
</tr>
<tr>
<td></td>
<td>Fred Webster</td>
<td>370,766</td>
</tr>
<tr>
<td></td>
<td>Helen Mayes</td>
<td>3,465,694</td>
</tr>
<tr>
<td></td>
<td>Jack Benetti</td>
<td>599,093</td>
</tr>
<tr>
<td></td>
<td>James Dowel</td>
<td>1,628,755</td>
</tr>
<tr>
<td></td>
<td>Jean-Michel Beauvis</td>
<td>1,144,535</td>
</tr>
<tr>
<td></td>
<td>Jonny Harston</td>
<td>637,536</td>
</tr>
<tr>
<td></td>
<td>Larry Stephens</td>
<td>1,600,095</td>
</tr>
<tr>
<td></td>
<td>Michele Lombardo</td>
<td>18,500,000</td>
</tr>
<tr>
<td></td>
<td>Monica Velasquez</td>
<td>6,314,782</td>
</tr>
<tr>
<td></td>
<td>Paul Atkinson</td>
<td>1,604,983</td>
</tr>
<tr>
<td></td>
<td>Peter Morzec</td>
<td>2,829,164</td>
</tr>
<tr>
<td></td>
<td>Prakash Thelkate</td>
<td>1,262,161</td>
</tr>
<tr>
<td></td>
<td>Roger Way</td>
<td>920,510</td>
</tr>
<tr>
<td></td>
<td>Rozalia Grel</td>
<td>607,120</td>
</tr>
</tbody>
</table>

d. Select ‘**Angela Richards**’ and ‘**Anne Green**’ from **Sales Rep Name** dropdown list.
<table>
<thead>
<tr>
<th>T05 Per Name Year</th>
<th>E1 Sales Rep Name</th>
<th>E1 Sales Rep Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010</td>
<td>Angela Richards</td>
<td>Anne Green</td>
</tr>
<tr>
<td></td>
<td>Aurelio Miranda</td>
<td>868,710</td>
</tr>
<tr>
<td></td>
<td>Bob Grant</td>
<td>1,394,826</td>
</tr>
<tr>
<td></td>
<td>Charles Brooks</td>
<td>1,487,858</td>
</tr>
<tr>
<td></td>
<td>Chris Jones</td>
<td>2,881,775</td>
</tr>
<tr>
<td></td>
<td>Edilberto Mandani</td>
<td>1,393,917</td>
</tr>
<tr>
<td></td>
<td>Fred Webster</td>
<td>370,766</td>
</tr>
<tr>
<td></td>
<td>Helen Mayes</td>
<td>3,465,694</td>
</tr>
<tr>
<td></td>
<td>Jack Benetti</td>
<td>599,093</td>
</tr>
<tr>
<td></td>
<td>James Dowel</td>
<td>1,628,755</td>
</tr>
<tr>
<td></td>
<td>Jean-Nichel Beauvis</td>
<td>1,144,535</td>
</tr>
<tr>
<td></td>
<td>Jonny Harston</td>
<td>637,536</td>
</tr>
<tr>
<td></td>
<td>Larry Stephens</td>
<td>1,600,095</td>
</tr>
<tr>
<td></td>
<td>Michele Lombardo</td>
<td>18,500,000</td>
</tr>
<tr>
<td></td>
<td>Monica Velasquez</td>
<td>6,314,782</td>
</tr>
<tr>
<td></td>
<td>Paul Atkinson</td>
<td>1,604,983</td>
</tr>
<tr>
<td></td>
<td>Peter Marzec</td>
<td>2,829,164</td>
</tr>
<tr>
<td></td>
<td>Prakash Thedkate</td>
<td>1,262,161</td>
</tr>
<tr>
<td></td>
<td>Roger Wray</td>
<td>920,510</td>
</tr>
<tr>
<td></td>
<td>Rozalia Grel</td>
<td>607,120</td>
</tr>
</tbody>
</table>

e. **Click Apply.** Now even 'E1 Sales Rep Name' value changes for this page.
Creating a Variable Prompt

In addition to functionality provided by the column prompt, variable prompt helps you in making a selection from a list of Custom Values and pass it on to an analysis through a Presentation Variable. You can use this presentation variable in your analysis.

Create a variable prompt for Revenue Projection.

Click New > Dashboard Prompt on the global header and then select the A - Sample Sales subject area.

a. In the Definition pane, click the New prompt icon ( ), and select Variable Prompt.
b. The New Prompt dialog box appears.

c. The Prompt for field allows you to name a Presentation Variable or Request Variable whose value will change as per the selection made in the variable prompt. Let the selection be Presentation Variable in the drop down list next to Prompt for field. Enter VarRevProj in the text box next to Prompt for field. You will further use the same presentation variable in the associated analysis.

d. The Label text box allows you to enter a meaningful label that appears on the dashboard next to the prompt. Enter Revenue Projection (%) in the Label text box (add a space following the colon).

e. The Description text box allows you to enter further extra information that you want to display.

f. As mentioned earlier, the User Input field's drop-down list provides you with the option to determine the User Input method for the user interface—in other words, the user will see one of the following: check boxes, radio buttons, a choice list, text field or a list box. You use this item in conjunction with the Choice List Values item to specify which data values appear for selection.

Select the User Input method of Choice List and the Choice List Values item of Custom Values. Add values which you want to display in the variable prompt choice list. Click on ( +) icon.
Add three values: 10, 20 and 30.

g. Expand the Options section. Variable Data Type field is used to select the data type of the presentation variable. You can chose one of the following data type for the presentation variable: text, number, date and time, time and none. Select **Number**.

h. The series of checkboxes allow you to restrict the amount of data returned. "Enable user to select multiple values" field lets you choose more than one value and "Require user input" field forces you to enter at least one value. "Default selection" allows you to select an initial value. Select **Specific Column Value** for Default Selection Field and click on ( ) icon.
The New Prompt dialog box should look like this:
i. Click OK.

The prompt is added to the Definition pane.
Save the prompt in the Regional Revenue folder as Revenue Projection Prompt.

Create an analysis to use Presentation Variable defined in Revenue Projection Prompt.

a. Create an analysis with the following columns:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>T05 Per Name Year</td>
</tr>
<tr>
<td>Base Facts</td>
<td>1-Revenue</td>
</tr>
<tr>
<td>Base Facts</td>
<td>1-Revenue</td>
</tr>
</tbody>
</table>

b. Create filter for T05 Per Name Year. Click the Value field and select 2010. Click OK.
c. Go to Edit Formula of 1 - Revenue column.

d. Select "Custom Headings" check box and enter Projected Revenue in "Column Heading" field. Enter following text in "Column Formula" field:

```
((@{VarRevProj}*0.01)+1)*"Base Facts"."1- Revenue"
```

Click OK.

Purpose of this formula is to calculate the projected revenue as per the presentation variable VarRevProj. Value of VarRevProj varies with Revenue Projection Prompt user selection.
e. Save the analysis as Revenue Projection Analysis.

Test the prompt.


b. From Catalog pane, drag and drop Revenue Projection Prompt and Revenue Projection Analysis into the new column.
c. Dashboard builder should appear as below:

![Dashboard Builder Image]

d. Save and run the dashboard. By default selection in Revenue Projection Prompt will be 10.

e. Select 30 from Revenue Projection (%) dropdown list.
f. Click **Apply**. ‘Projected Revenue’ value changes for this page.

![Dashboard Screen](image)

**g.** You can try selecting other values in the prompt for ‘Revenue Projection (%).’ Click **Apply** to rerun the dashboard prompt.

This concludes the topic on prompting to filter analysis.

### Summary

This tutorial has covered how to build, format, and customize Oracle Business Intelligence (BI) analysis and create and update dashboards by utilizing these analysis.

In this tutorial, you have learned how to:

- Use Favorites Menu, global header links and BI Client Installer
- Create, edit and format an analysis
- Create and work with graphs, pivot tables, performance tile and simple trellis
- Create master-detail linking between two or more views
- Create and work with several types of views
- Explore My Dashboard, create and edit a dashboard
- Add, edit and format a new dashboard page
- Create various types of dashboard prompts

### Resources

- [Oracle by Example - Oracle Business Intelligence Enterprise Edition](#)
- [Oracle Learning Library - Home](#)
To navigate to a particular section in this tutorial, select the topic from the list.

- Overview
- Beginning the Analytic Process
  - Logging In
  - Favorites Menu
  - Searching the Catalog (Basic Search)
  - BI Client Installer
- Creating Analysis
  - Creating an Analysis and Using the Analysis Editor
  - Filtering, Sorting, and Saving your Analysis
  - Creating Selection Steps for your Analysis
  - Formatting and Adding Totals to your Analysis
- Adding a Graph to an Analysis
  - Enhancing an Analysis by Adding a Graph
  - Formatting the Graph
- Working with Pivot Tables, and Master-Detail Linking
  - Creating an Analysis with a Pivot Table View
  - Formatting a Pivot Table and Adding Calculations
  - Creating a Master-Detail Linking
- Adding Performance Tile to an Analysis
- Adding a Simple Trellis to an Analysis
- Working with Other View Types
  - Creating a Narrative View
  - Creating Column Selector and View Selector Views
- Building Dashboards
  - Exploring and Editing My Dashboard
  - Creating a Dashboard
  - Editing a Dashboard
  - Saving a Customized Dashboard and Setting Preferences
  - Exporting the Dashboard to Excel Spreadsheet
- Prompting to Filter Analysis
Creating a Named Dashboard Prompt
Creating a Column prompt
Creating a Variable Prompt

Summary

To help navigate this Oracle by Example, note the following:

**Hiding Header Buttons:**
Click the Title to hide the buttons in the header. To show the buttons again, simply click the Title again.

**Topic List Button:**
A list of all the topics. Click one of the topics to navigate to that section.

**Expand/Collapse All Topics:**
To show/hide all the detail for all the sections. By default, all topics are collapsed

**Show/Hide All Images:**
To show/hide all the screenshots. By default, all images are displayed.

**Print:**
To print the content. The content currently displayed or hidden will be printed.